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Direct Admit Wisconsin

What is Direct Admit Wisconsin?

Direct Admit Wisconsin is a program designed to identify eligible students from Wisconsin
high schools for automatic admission to participating universities within the University of
Wisconsin system. This guide outlines how to use the tools available in Skyward SMS 2.0 for
participating high schools.

How can my high school/district participate?

The tools available in this guide are only available if your district has opted into the Direct
Admit Wisconsin program through the Universities of Wisconsin. For more information on
this you can visit https://www.wisconsin.edu/direct-admissions/ or email
directadmitwi@uwsa.edu. Once your district has been recorded as participating through the
Universities of Wisconsin, the screens and options in this guide will be available in your
database.
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Student Opting in/out

Direct Admit Wisconsin Configuration

The Direct Admit Wisconsin Configuration screen allows you to identify the default value for
your students to participate in the Direct Admit Wisconsin program. It also allows the
selection of the graduation years available to participate and the setting of when the
program tab will display in Family and Student Access via the start and cutoff dates.

To access this screen, navigate to Web Student Management > Office > Grading >
Transcripts > Product Setup > Configuration > Direct Admit Wisconsin
Configuration. (WS\OF\GR\TR\PS\CF\DC)

If the fields on this screen are read-only, a message will display at the top of the screen
directing you to contact the Universities of Wisconsin to request participation.

rf“‘ School District (000) (= Darth Vader  Account | Preferences | Exit | | 7
SKYWARD
Home w Students Families Staff ':%I.:J_e.n‘.. .F_oo_? 8,8 Administration ‘\-‘UGI\-‘ g S CUSI:'.“_ Q
Services  Service Access Plus Reports
< Configuration % (8,075) P 1 [ el syravoresy $Newwindow €5 My Print Queue §8

=1{-5 Configuration - CF

tstrict Direct Admissions Configuration - DC
L
A Not secure skydevappprog1/scripts/cgiip.exe/WService=dylanatest2/sgr..
Direct Admit Wisconsin Configuration ( @ w8 & & 7 #
Defaults Gaee

& Grad Year Entry - Entity 000 - WOH\ORGRTRPS\CAD.. — (m] x
Student Default: () Send ® Do Not Send |

A Mot secure  skydevappprog1/scrip
Display Options

Grad Year Entry (218)
Grad Years = &
Grad Year Entry

Srad Yt | Start Date Cutoff Date
[ 1001 oures/anas | owroasaoas ||

1. Select the appropriate Student Default value under the Defaults heading.

a. Send: When this option is selected the students will automatically have their
information sent to the Universities of Wisconsin. To remove a student from
the program their records must be updated to not send.

b. Do Not Send: When this option is selected students will default to having
their information withheld from the Universities of Wisconsin. To opt in and
participate in the program, students and/or guardians must update their
records to send.

2. Select the Add button, under the Display Options heading, add a graduation year
with the start and cutoff dates that identify the duration of when the Direct Admit
Wisconsin tab is available in Family and Student Access. This program is for students
currently in their junior year, so the dates should be set accordingly.
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Family/Student Access Configuration

The configuration settings for Direct Admit Wisconsin in Family and Student Access allows
you to enable guardians and students to update the student’s individual preferences
regarding program participation. You will also have the option to identify if a Family
Educational Rights Privacy Act statement (FERPA) agreement should be displayed.

To access these settings, you can navigate to Web Student Management > Families >
Family Access > Product Setup > Configuration > Entity Configuration.

1. Expand an entity and expand the General Information heading under the entity and
select Edit next to Direct Admit Wisconsin.

Direct Admit Wisconsin Entity Configuration '® TS
Entity: 400 Section and Application: | General Information - Direct Admit Wisconsin Save
Back
Guardian Options Student Options
[ Disable Application _| Disable Application
Do Mot Display Button Do Mot Display Button
Display Button and Message Display Button and Message
] A
Allow Update of Direct Admissions Send '_ Allow Update of Direct Admissions Send
Display FERPA Statement || Display FERPA Statement

Use Standard FERPA Statement
Create an Entity Defined FERPA Statement

() Use Standard Electronic FERPA Statement
'® Create an Entity Defined FERPA Statement

Electronic FERPA Statement Electronic FERPA Statement

Sample Opt-Out/In Form for Diract Admit Wisconsin

Please note this is 2 SAMPLE. Do not use this form
until it is reviewed and revised to meet the
reguirements of your school and district under

Sample Opt-Out/In Form for Direct Admit Wisconsin

Please note this is a SAMPLE. Do not use this form
until it is reviewed and revised to meet the
requirements of your schoaol and district under

FERPA. FERPA.

Dear Parent/Guardian: Dear Parent/Guardian:

M The (insert high school name) is

The Skyward Senior High is participating in a
participating in a program called Direct Admit

program called Direct Admit Wisconsin. Direct Admit .

2. If Disable Application is checked, you can select to hide the tab in Family or Student
Access completely or display the option but with a message explaining why it cannot
be updated. If the Disable Application is unchecked additional settings are available.

3. Select Allow Updates of Direct Admissions Send to allow the default value set for the

district to be overridden. Note: For the update to be made for a student, they must
also have an active record in the Direct Admit Wisconsin area under the Grading
module for their graduation year.
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4. Select Display FERPA Statement to allow FERPA compliant text to display.
a. Choose Use Standard Electronic FERPA Statement to display the default text
Skyward has prepared.
b. Choose Create an Entity Defined FERPA Statement to enable the ability to
update the default text that will display for the entity.
5. These settings can be updated for both Family and Student Access, and once
complete, click Save.
6. These settings can be cloned across entities by selecting the Clone button from the
Entity Configuration screen.

Student Profile Maintenance

From the Student Profile, you can verify and maintain individual student Direct Admit
Wisconsin program participation preferences. This is helpful if your counselors or other
administrative staff need to update a student’s participation in the program.

To access this, navigate to Web Student Management > Student > Student Profile > expand
the GPA tab group > select the Transcript sub-tab.

At the top of the tab, under the Transcript heading, you can see the student’s current
preference on the Direct Admit Wisconsin field. The Send or Do Not Send radio buttons
default based on the Direct Admit Wisconsin Configuration Default setting discussed above.
If a student’s preference is updated from the default setting, the Override box will be
checked, as well as the appropriate radio button for Send or Do Not Send.

High School - Grades 9 to 12 (400) (= F5S Alert  Jennifier Waldrenser  Account | Preferences | Exit | | 7
SKYWARD
Students . = | Student | Food = Educator | Advanced | Federal/’State | Custom
Home |~ B0 oL Families | Stafl | gonices | gervipe | OMCe  AAMINISIANON | ooooce Plus | Features | Reporting | Reports |
4§ Transcript Tab % (1,149) 9§ A [ @l syrevortesw ) NewWindow €5 My Print Queve
Attendance “ | Student. |ABILAETHESE ~ | Abilascr, Ethelene H 4| P | @ Ranges|__ Add Delete Transfer || Pseudo
w Scheduling
Current Grad Year (Grade): |2025 (11) DOB (Age): 05/21/2007 (16) Entity, School, Status: 400, HS, A Default: 400, HS, A 1w
Future Customize
Grades Advisor: Hampelser, Nadine N Gender: F NY Status:|A OtherID: 4817 Phone: (555)982-8017
> GPA .
Transcript
Transcri .
L | Direct Admit Wisconsin: | | Override © Send Do Not Send
WI/NCLE .
Schools Where Transcripts Were Sent = @
» Special Prgms 2 Print
AtRisk = =
» Special Ed

To update the student’s value, click the edit button next to the Direct Admit Wisconsin field.

e Override: Check this box to enable the ability to update the student’s program
participation from the default value set for the district.

e« Send: When selected, this indicates the student is participating in the Direct Admit
Wisconsin program, and their qualifying information will be sent to the Universities of
Wisconsin.

e« Do Not Send: When selected, this indicates the student is not participating in the
Direct Admit Wisconsin program, and their qualifying information will not be sent to
the Universities of Wisconsin.
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Family/Student Access

From Family Access and Student Access, respectively, guardians and students can be
provided with the ability to review and even update their preference to have the student
participate in the Direct Admit Wisconsin program.

f Family Access
SKYWARD All Students '~ Skyward Homepage n
Direct Admit Wisconsin
Home
Ethelene (High School - Grades 9 1o 12)
AL ELECTRONIC FERPA Statement
Enrollment Sample Opt-Out/in Form for Direct Admit Wisconsin
Arena Please note this is 3 SAMPLE. Do not use this form until it is reviewed and revised 10 meet the requirements of your school and district under FERPA
Scheduling Dear Parent/Guardian
Ethnicity/Race The Skyward Senior High is participating in a program called Direct Admit Wisconsin. Direct Admit Wisconsin is designed to provide a place for all
Wisconsin high school students 1o access a world-class public education by proactively offering them admission 1o the Universities of Wisconsin
Calendar Based on a review of your student's 11th grade transcript (grade point average and math coursework), you and your student may receive an email in July
ind¥ catrg whi re providing them direct admission, and the next steps they are to take in order to learn more about enrolling within the
Gradebook Universities of V sin. Participating in this program does not commit your student 1o attend the Universities of Wisconsin. To facilitate the
administration of this program, the following information will be shared by the school with the Universities of m;cons.n Name, WISEid, Local Student
District ID, confact information. legal sex, race/ethnicity, GPA and high school transcripts
Attendance
There are 10 UWSs participating in Direct Admit Wisconsin for Fall 2025. They are UV¥-Green Bay, UW-Milwaukee, UW-Oshkosh, UW-Parkside, UW-
Student Info Platteville, UW-River Falls, UW-Stevens Point, UW-Stout. UW-Superior and UW-Whitewater
Busi For further information on Direct Admit Wisconsin please see the foliowing FAQ (link out)
usin
9 FOR THOSE OFFERING AN OPT-OUT PROCESS INCLUDE If you DO NOT WANT your student to participate in Direct Admit Wisconsin, please (insert
£ Senvi what parents need to do here) FOR THOSE OFFERING AN OPTAN PROCESS INCLUDE If you want your student to participate in Direct Admit
ood Service Wisconsin, please (insert what parents need 1o do here)
Schedule I would like to participate in the Direct Admit Wisconsin program
iscipli
Discipline Jordon (High School - Grades 9 1o 12)
Test Scores Direct Admit Wiscensin is not available because the student's Grad Year doesn't qualify
Fee
Management
Activities
Student Services
Graduation
Requirements
Conferences

The Electronic FERPA statement displays based on your school’s preferences and will only be
shown for those students who are eligible to participate based on your district settings. If
Direct Admit Wisconsin is not available for all students that fall within the family, you will
see a message indicating that.

The checkbox next to the statement, I would like to participate in the Direct Admit
Wisconsin program,” defaults according to your school’s preference. When checked,
indicates the student is participating in the Direct Admit Wisconsin program, and their
qualifying information will be sent to the Universities of Wisconsin. When unchecked,
signifies the student is not participating in the program, and no qualifying information will
be sent to the Universities of Wisconsin.

Once the appropriate update is made to the checkbox, the value is automatically saved, and
the student or guardian is notified that their update has been made.
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Academic Review

On Track to Graduate Student Profile

Now that students/guardians have been able to opt in, you will heed to continue to do the
academic review and ensure that students are meeting the criteria set forth by Universities
of Wisconsin and determine which tiers the students fall into. To help with this, we have
added an On Track to Graduate flag to the student profile. You will locate this by navigating
to Students > Student Profile > GPA > Transcript:

SKYWARD
T A g ! -~
Home v [l S| Families | Staff | Student | Food ' e o | adnvinictration | Educator | Advanced  FederaliState | Custom o
Services  Service Access Plus = Features Reporting Reports
< M Transcript Tab & (17199) H _V Q (Ol S Favoritesw 5] 7] New Window £ My Print Queue g
Identity | Student: [[—— Jo < | » | @ Ranges Add Delete Transfer Pseudo
Address =
Birth Hist Grad Year (Grade): 22025 (11) | DOB (Age): 12/18/2006 (17) | Entity, School, Status: 400, 400, I Default: [200, 200, A
School Path : s
Vehicles -
N i Advisor: Gender: F NY Status: A Other ID: | N Phone:
Web Access
Change Hist Transcript
Wellness Screening
% Direct Admit Wisconsin: . Override © Send Do Not Send Edit
w Entity
" . | On Track to Graduate: | Override ' Yes No | Tier: 6 History
Entity Info

What does it mean for a student to be ‘On Track to Graduate’? Admission to the Universities
of Wisconsin through Direct Admit Wisconsin is conditional upon a student graduating. A
student is ‘on track to graduate’ if they are going to complete the credit requirements as set
forth by your high school graduation policy. All high schools participating in Direct Admit
Wisconsin must ensure that their graduation requirements include the following unit areas
required by the University of Wisconsin Freshmen admission policy. If the student is
accomplishing this requirement, they should be considered on track to graduate. In
addition, 3 units of math must be college preparatory math. The list of Math courses
deemed college preparatory by the Universities of Wisconsin can be found in the Direct
Admit Wisconsin Toolkit under the Program Information folder. Again, all other subjects,
follow your high school's graduation policy. (https://drive.google.com/drive/folders/1 dP-
nV10 NNFn88if-4ITOEkptGvh]2z)

Academic Subject | Academic Units |
English 4 units
Social Science 3 units
Mathematics 3 units
Natural Science 3 units

Students must choose additional units from the
subjects above and/or foreign language, fine arts, 4 units
computer science and other academic areas.

Current as of: 7/18/2024 Page 7 of 23 Version 05.24.06.00.03


https://drive.google.com/drive/folders/1_dP-nV1O_NNFn88if-4lTOEkptGvhJ2z
https://drive.google.com/drive/folders/1_dP-nV1O_NNFn88if-4lTOEkptGvhJ2z

7
SKYWARD

SKYWARD DOCUMENTATION - DIRECT ADMIT WISCONSIN

Course Groups

Hopefully there are a lot of students participating in this initiative; in which case, we realize
it can be time consuming to go through and flag each of them individually. To help with this,
we have created a utility to calculate those students who are on track to graduate and
update the field mentioned above. To run this utility, you will need to set up Course Groups,
so the utility knows which courses align with a particular academic subject. To set up course
groups navigate to Web Student Management > Office > Current Scheduling > Build Course
Master > Codes > Course Groups (WS\OF\CS\BC\PS\CO\CG).

Course Groups A @ QO S5 2
Course Groups Selection iy Add
Code & Short Descriplion Long Description Status Eait
a0 a0 | A | ok
0 Online Online A Back
P/F Pass/Fail Pass/Fail A
TA Teacher Advisor Teacher Advisory A
Course Groups A@ T o 2
Course Group Codes Save
Back
* Code: 8
* Short Description: [Math |
* Long Description: [(WI Direct Math )
Status: @ Active O Inactive
Asterizk (*) denotes a reguired field

There are three different ways to add courses to your course groups once they are created:
1. Individually add Course Groups at the course level.
2. Mass add Course Groups to a range of courses.
3. Add Course Groups via your Curriculum Master.

**Note: You will need to make sure that courses from previous school years are added to
course groups so that your Juniors have all their courses accounted for when this utility is
run!! This is a one-time setup and once your courses are added they will clone forward year
to year.
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Individual Course Group Add

Adding courses to your course group individually can be found by going directly through
your course master. Web Student Management > Office > Current Scheduling > Build

Course Master > Course Master > Edit Course (WS\OF\CS\BC\CM\CM).

Edit Course

Entity: 400 Morthfield High School School Year: 2023-24 Curriculum: mﬂ::i J» | MATH APPS 1

* Course Key: * Short Description: [MATH APPS 1 * Long Description: [MATH APPLICATIONS I |

General Properties

Course Length Set:[YR
Grade Set: YEAR LONG

- YEAR LONG v

* Grade Ranges: -

Subject:(MAT = MaTH

Save
Save and
Go to Prev

Course
Save and

Go to Next
Course

Back

e Fees:
. ;ou;;e Statu:: zcti\_fe . : Department:| MAT v | MATH Academic Hours: 1.000
edive/Required: | Reguire .
- tq ot = Activity Link: = Earned Credits: 1.000
ategory: : = CHE Code: . Available To Online Scheduling
Schedule Type: | Norma — [ Prohibit Student from Dropping
Scheduling Priority: | @ - Lowest Priority b Report Card: - Core Academic Subject
Grading System: | Average ol Lock Group: bl Grade Course
. ::d‘;"}f _TYFE: :rad:d = vt -] Current Requests: 0 Keep Attendance
:[@ = No Priority i
eamT e : :‘:]rll_t; : | FE—— Maximum Seats Available: 0 gj Repeatable For Credit
ranscrip : nclude Tran in . . Locked to Scheduler
Estimated Nbr of Sections: -
Website Address: | ] [ Self-Contained Course

| Actual Nbr of Sections: 1]

~]@

Allow Teacher Conferences
[ Default Course for Career Plan

Website Display: |
Course Credit Basis: |
Note:

Maximum characters: 200, Remaining characters: 200

Hormal * GPA Set 1:[1 = |NON WEIGHTED| GPA Credits 1: [ Allow GPA Set Override At Section Level
* GPA Set 2:[1 v |NON WEIGHTED| GPA Credits 2: [ 0.000

Cross-Entity Course Enrollment Information

[normal | Details
Entity: Course:
Qualifications add = Cuslification
Position Subject
Description Position Description Subject
Mo Qualifications Selected
Course Group(s) Add Course Group
Code Description
Mo Course Group Selected
Course Groups Selection A @7 S |7
Course Groups Selection & 'i'h Select
Add
Add Code & Sheaort Description Long Description Status
O |aw AVID AVID A - Edit
7 Iman | wiovectha . Sui
O o Online Online A ==
O PF Pass/Fail Pass/Fail A —
- TA Teacher Advisor Teacher Advisory A
Select All
Unselect Al
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Mass Add Course Groups based on Course Range

To Mass Add your course groups, you would use the Mass Change Course Master Utility to

set the course groups by selecting your course ranges

and then adding the course groups to

the courses that fall within that range. Web Student Management > Office > Current
Scheduling > Build Course Master > Utilities > Mass Change Course Master Fields

(WS\OF\CS\BC\PS\UT\MC).

Mass Change Course Master Fields
Mass Update Course Master Field Ranges

Utility Description

This utility will process Course, Class, and Class Meet records within the entered ranges and update field values with

value.

Template Settings

* Template Description:
[ share with other users in entity 400

Course Ranges

Course Ranges Entity: 400 Morthfield High School School Year: |2023-24

the entered new values where the value matches the entered current Sack

Course Groups

O Enter Exact Match O Change Individual Course Groupd @ a, . Delete Course Groups

Add Course Groups

Course
Groups
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Add Course Groups from the Curriculum

To add courses to your Course Groups from the Curriculum level you would go to Web
Student Management > Office > Current Scheduling > Build Course Master > Curriculum
Master > Edit (WS\OF\CS\BC\CU).

Edit Curriculum Master

* Entity: [888 - SKYWARD SCHOOL DISTRICT

v | = Curriculum Key: [02PE

* Short Description: |02 PHY ED

General Properties:

Course Defaults:

* |YEAR LONG
¥ |EXERCISE AND 55

Length: | YR

Department: | ESS

Subject: ESS ¥ |EXERCISE AMD 55
Course Type: v
Academic Hours: 0.00

Earned Credit: 0.000

Mo Qualifications Selected

[ Default Course for Career Plan

GPA SET 1:|1 * | NON WEIGHTED GPA Credits 1:
GPA SET 2:(1 * | NON WEIGHTED GPA Credits 2
GPA SET 3:1 * |NON WEIGHTED GPA& Credits 3:
GPA SET 4:|1 ¥ |NON WEIGHTED GPA Credits 4:
GPA SET 5:|1 * |NON WEIGHTED GPA Credits 5
GPA SET 6:|1 * |NON WEIGHTED GPA Credits 6
GPA SET 7:|1 * |NON WEIGHTED GPA Credits 7:
GPA SET 8:|1 * |NON WEIGHTED GPA Credits 8:
GPA SET 9:(1 * |NON WEIGHTED GPA Credits 9:
Qualifications: Add a Qualification
Position
Description Position

* Long Description: [SECOND GRADE PHYSICAL EDUCATIH

Elective/Required: | Elective

Category: | Regular

Schedule Type: | Normal

Grading System: | Average

LME1E4ESIES

Grading Type: | Graded

Core Academic Subject
B4 Grade Course
Keep Attendance

0.000 [ Repeatable For Credit

0.000 Transcript GLO:

Include Tran GLO in GPA

Course Credit Basis: [

|

0.000
0.000
0.000
0.000
0.000
0.000
0.000

Subject

Description Subject

Course Group{s) Add Course Group

Code Description
Mo Course Group Selected

Once you add the Course Group to the curriculum, you must copy the Course Group to all
the courses that exist within the curriculum. You do this by leveraging the Mass Copy
Curriculum Master Information Utility. Web Student Management > Office > Curriculum &
Assessment > Curriculum > Utilities > Mass Copy Curriculum Master Information

(WS\OF\CA\CM\PS\UT\CC).
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SKYWARD

Mass Copy Curriculum Master Information

This process will mass copy information from the Curriculum Master records within the
'Curriculum Master Ranges' selected to its linked Courses within the "Course Ranges’ selected.
The fields updated are based on the user's selection in the 'Fields to be Updated' area.

Curriculum Master Ranges

Course Status

@ poth O aAdive O Inactive

Elective/Required
® Both O Elective ' Required

L] all Entities | Entities |
Low High
Curriculum Key: | |[zzzz777777 |
Curriculum Master Status
®Both O Adive O Inactive
Course Ranges
() Al Entities | Entifies |
Lowy High
School Year: | 2024 [ 2024
Course Key: | |[zzzzeezzzz |

Fields to be Updated
Owerwrite Existing Data

[ course Key O Category

) short Description (] Elective/Required
] Long Description [ schedule Type
[ Department ) Grading System
] subject O Grading Type

[_) Major Subject Area [ core Academic
) course Type [ Grade Course

) course Length O Keep Attendance
[ Academic Hours ] Earned Credit
] Grade Range

[ Repeatable (] use Grad Req Credit
[ qualifications [ career Plan Default
[ GPa Set 1 [ status

[ GPa set 2 [ Gra Credits 1

[ GeA set 3 [ GPa Credits 2

[ GPA Set 4 O GPa Credits 3

[ GeA set 5 [ GPa Credits 4

[ GPa Set 6 ] GPa Credits 5

[ Gpa set 7 [ P Credits &

[ Gpa set 8 [ Gra. Credits 7

S [ GPa Credits 8
Course Group [ GPa Credits 9

[ course Credit Basis

[ Grad Requirement Credit

[] indude Tran GLO in GPA

A D 5|7
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On Track to Graduate Utility

Now that you have your course groups set up, you will use them when running the WI On-
Track Calculation Utility. This utility will take the courses that students have achieved that
fall within the course groups selected and calculate if the student has met the criteria or
not. Remember, students are juniors this year, so set the credits required to graduate at
the accurate number of credits that they are supposed to have at this point in their high
school career.

Depending on if the student has or has not met the criteria, it will automatically update the
On Track to Graduate Flag on the student profile. There is the option to override this flag if
needed by navigating to the Student Profile > GPA > Transcript, if the override option is
used, it will not be impacted by this utility. To find this utility, navigate to Web Student
Management > Office > Grading > Transcripts > Product Setup > Utility > Direct Admit WI
On-Track Calculation (WS\OF\GR\TR\PS\UT\OT).

Edit Report Ranges (180) AT S 28
Template Settings Save
* Template Description: | Sagi"&:"d

O share with other users in entity 400 Back

Student Selection

@ By Range O By Individual Ranges
On-Track Requirements = Q@ Add
Priority a | Subject Credits | Course Groups Edit
Cengsh | tooeve | RGO
2 Math 2.00 MTH
3 Science 1.00 sCI
Move Down

3 records displayed

NOTE: If a class falls into more than one On-Track Regiurement, credits will be applied by Requirement Priority

Course Ranges

Low High
Course Entity: @ By Range O By Selection List
Course Entity: 27272
Grade: 09 12 Include Courses with Transcript GLO
Class School Year: 1900 9999

Include Credits From Future Scheduled Classes
Include Credits From Future Course Requests

Asterisk (*) denotes a required field
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After you run the utility, it generates the Calculate Direct Admit WI On-Track Status Report.
This report will display which students are on-track and which are not, in addition to a
breakdown of all the On-Track requirements that were set up within the utility ranges.

Student Key Student Name On Track Priority Subject Credits Needed Credits Met

..........................

Please review this report and cross reference the students who are listed as ‘Met No'. If
these students are in fact on track to graduate, you can choose to go and override the On
Track to Graduate flag by navigating to the Student Profile > GPA > Transcript. Or you can
update the On-Track Requirements Credits and run the utility again:

On-Track Requirements &) @ Add
Priority a | Subject Credits | Course Groups Edt
| ilEngish 100eN | EECET
2 Math 2.00 MTH
3 Science 1.00 SCI
Move Down
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Transcript

Now that you have determined which students are or are not on track to graduate, you will
need to run transcripts. You run your transcript by navigating to Web Student Management
> Office > Grading > Transcripts > Report > Transcripts (WS\OF\GR\TR\RE\TR); however,
there are a few important items that need to be done to ensure the transcripts are sent
correctly:

1. In student ranges you will need to identify the 11th grade students and then select
the Direct Admit Wisconsin send option. This ensures that you are running the
transcripts for the correct grouping of participating students.

@ Student Ranges - Entity 400 - WS\OR\GR\TR\RE\TR - 12007 - 05.24.02.00.06 - Google Chrome - O X

A\ Not secure  skydevappprog1/scripts/cgiip.exe/WService=jaceoTest/sgradedit052.w?isPopup=true

Student Ranges (336) A0S 28
Student ranges are based upon the current entity’s school year, not the report’s school year.
O By Individual Grades By Grade Range (O By Grad Year Range (O By Grad Req Base Year Save
Low High Back
Sfudcl lt :\Cy . _L‘“‘l—l—l-‘l.l—
Grade/Grad Yr: |10 2026 10  |2026 e ——
Advisor: | |222272727277272 Select 11th grade
Counselor: | [zzzz22272772 |
Feeder School: | | 22227227777
Zip Code: | | |zzzz2227222
Student Status: O Active (O Inactive @) Both
Next Year Status: O Active O Inactive @ Both
Resident: OYes (ONo @ Both
Current Year Member: OYes (O No @ Both
Graduated: OYes (O No @ Both
Gender: O Male (O Female @ Both
Direct Admit Wisconsin (ODoNotSend @ Both
All Student Types (] Filter By Activities
All Races (CJFilter By Processing Lists
All Schools (] Filter By Methods of Instruction
All Homerooms (JFilter By EW Withdrawal Date
All Calendars From: 01/01/1900 To: 12/31/9999

All Categories
All Default Entities
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2. You will also need to make sure that you add the Student Detail Options of Student
ID: State ID Number & Additional ID: Other ID because these fields are required to
be on the transcript by the Universities of Wisconsin. You can find these fields under
Selection/Printing Options > Student Detail Options. You will need to make sure that
the Student ID field has the ‘State ID Number’ and the Additional ID field has ‘Other
ID’ selected.

Selection/Printing Options

Print Header Page for Sort Sequence One Print Where Transcript Are Sent To
_J Print Duplex Transcript Print Additional Options On One Page
LJ Save Transcripts To Student Portfolio

Graduation Year/Credits

Grade Selection

Student Detail Options

Today's Date on Transcript

Student ID: [ State ID Number v] Middle Name: [Middle Initial v
Additional Id: | Other ID V‘ Name Type: | General Profile Name v E?__]
Name Order: | First - Last v ' Print Entry/Withdrawal Dates: | First Entry/Last Withdrawl Date v
Parent/Guardian Name U Total Community Service Hours
Home Phane Number | | projocted Graduation Date f‘ﬂ

Direct Admit Tier Utility

Now that you have your Transcripts saved as PDFs, we need to calculate the tiers that
students fall into, so we know which universities they are eligible to be admitted to. To
accomplish this, you will need to run the Direct Admit WI Tier Calculation Utility. Items to
note are that your GPA Method must be unweighted, and you only need to upload your
transcripts when you are selecting the ‘Create and Send Direct Admit Wisconsin Data File’
which then generates a CSV and sends it to the Universities of Wisconsin. You find this
utility by navigating to Web Student Management > Office > Grading > Transcripts >
Product Setup > Utility > Direct Admit WI Tier Calculation (WS\OF\GR\TR\PS\UT\DA).
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Edit Report Ranges (198)

Template Settings

* Template Description: [b_ |
(L) Share with other users in entity 400

Student Selection

@By Range O By Individual Ranges
Utility Options
Unweighted GPA Method: [1 - Normal v

Create and Send Direct Admit Wisconsin Data File

Transcript PDF File: | Choose File | No file chosen

Uploaded File: Direct Admit Wisconsin - Data Element Specifications v3.pdf

Asterisk (*) denotes a required field

Upload

View File

A -

Save

Save and
Run

Back

2

If you do not wish to generate a data file for the Universities of Wisconsin currently, simply

uncheck this option and you do not need to add your Transcript file. You would do this if you
were interested in seeing where students are falling within their tiers, you can run the utility
with this option unchecked, and this will update the Tier level on the student profile, in

addition to generating the Calculate Direct Admit WI Tier report:

p Categories Schools Where Transcripts Were Sent

Families | Staff Student Food Office | Administration Educator Advanced Federd
Services  Service Access Plus = Features Rep
~ Transcript Tab ¢ (1,137) Yy 2 2 b wra
Address
“ | Student = SR, BXTR 4| p Ranges Add
Birth Hist Slugent. [ESRATE ) 8 ESil2y) © Rano
School Path
Vehidl Grad Year (Grade): 2025 (11) DOB (Age): 12/19/2006 (17) Entity, School, Status: 400, 400, I
ehicles
Wk docaia Customize
Change Hist Advisor: NY Status: A OtherID: T5¥12 Homeroom Teacher
Wellness Screenin -
9 Transcript
w Entity
y Direct Admit Wisconsin: . Override © Send ' Do Not Send Edit
Entity Info
Obligations On Track to Graduate: = Override ' Yes No Tier: 6 History

Current as of: 7/18/2024 Page 17 of 23

Version 05.24.06.00.03



SKYWARD DOCUMENTATION - DIRECT ADMIT WISCONSIN SKYWARD
Student Key Student MName Dizect Admit On Track Unweighted GPA Tiex
Data File
Transcript PDF File

If you do wish to generate the data file and send it to Universities of Wisconsin, we process
all students whether they are on track to graduate or not and send the tier calculation in
addition to transcripts to an agreed upon secure location, so that Universities of Wisconsin
has access to it.

Reporting

You can generate reports when running Direct Admit Utilities; however, in addition to these
reports we've also added Direct Admit fields to data mining. You can find data mining by
navigating to Web Student Management > Student > Students > Data Mining (WS/ST/DM)
and for Field Areas go to Transcript and then Direct Admission.

Please pull and cross reference any/all students who are not on track to graduate and make
sure that they are truly not on track so that they receive a tier and a letter with the colleges
they are directly admitted to.

. Data Mining (654) » A [ 6B siravonesy T Now Window €38\
Report Name: dafdasdf
Report Title: dafdasdf
\ tion: Portrait Student Status: Active Excel Export: Default Default Entity: Both
® Field Selection O Field Search

Are
Online Assignments
14

Report Width: 0/132
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Sending Admittance Letters to Students

University of Wisconsin Guidelines should be followed when generating and sending
admission letters. For the 2024 school year, it is being urged that these letters are sent
beginning Monday, July 29%, 2024. You will find the letters by navigating to Web Student
Management > Office > Grading > Transcripts > Report > Direct Admit WI Letters
(WS\OF\GR\TR\RE\DA).

Edit Report Ranges (121) A S 28

Template Settings

[7)]

ave

: Save and
* Template Description: |Test ‘p:‘,:tn
() Share with other users in entity 400
L_J Print Greenbar

® 6 Lines Per Inch O 8 Lines Per Inch

Back

Student Selection

@By Range O By Individual Ranges

Send Options

7Send Letter to Student Portfolio [}
[_J Skip generating consolidated PDF of all letters

Asterisk (*) denotes a required field

Much like when you generated the Transcript, you will want to go into the student ranges
and run it for your 11t graders and select the Direct Admit Wisconsin Send option.

Please note: If you have run your year-end processes by this point you will want to run it
for 12t grade instead of 11t grade.
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Student Ranges (133) A @O S 28
Student ranges are based upon the current entity's school year, not the report’s school year.
O By Individual Grades By Grade Range () By Grad Year Range (O By Grad Req Base Year Save
Low ~ High Back
Student Key: | |abzzzzzzzzz |
Grade/Grad Yr: | | 9999 { | 0000
Advisor: | |2222Z2727227272Z |
Counselor: | | zzzz2272277 |
Feeder School: [ | 222277227772 ]
Zip Code: | | Wr7777777:72
Student Status: O Active (O Inactive @ Both
Next Year Status: O Active O Inactive @ Both h
Resident: OYes (O No @ Both
Current Year Member: OYes (O No @ Both
Graduated: OYes (O No @ Both
Sender O M C) Female @ Both
Direct Admit Wisconsin: () Send [ Do NotSend (@ Both
All Student Types (CJFilter By Activities
All Races ' (JFilter By Processing Lists
All Schools (CJFilter By Methods of Instruction
All Homerooms () Filter By EW Withdrawal Date
All Calendars From: 01/01/1900 To: 12/31/9999
All Categories
All Default Entities

The letters that are generated were provided to Skyward by the Universities of Wisconsin,
has the list of universities that the student has the opportunity of attending, and has the
Associate VP for Enroliment and Student Success at Universities of Wisconsin Administration
signature included on it.
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UN'VERSIT'ESﬁ Office of Enrollment and Student Success

1500 Van Hise Hall, 1220 Linden Drive, Madison, W1 53706

w ' Sco N SI N www.wisconsin.edu/direct-admissions or 800-442-6459

05/14/24

N, A,
01 BT N

O R
0o el i B

Congratulations, Nina!
We are thrilled to inform you that you have been DIRECTLY ADMITTED to the Universities of

Wisconsin listed below for the Fall 2025 semester! Based on your high school academic record
and performance, we are confident you will excel at any of these UW universities.

UW-Green Bay UW-Green Bay, Manitowoc Campus
UW-Green Bay, Sheboygan Campus UW-Milwaukee

UW-Parkside UW-Plateville, Baraboo Sauk County
UW-River Falls UW-Stevens Point

UW-Stevens Point at Marshfield UW-Stevens Point at Wausau
UW-Stout UW-Superior

UW-Whitewater UW-Whitewater at Rock County

The Universities of Wisconsin provide opportunities for all Wisconsin high school students to
earn a world-class education. We hope you choose one of our universities as the next step in
your educational journey.

This offer is only for admission to the designated Universities of Wisconsin and not to any
specific major or program of study. Your admission is conditional upon successful completion of
the required academic courses, maintaining your current GPA, graduating from a recognized high
school, and submission of an official final high school transcript.

To connect with your Direct Admit UW universities and start your path to college, go to the
Universities of Wisconsin admissions portal (apply.wisconsin.edu/direct-admit) and
complete the Direct Admit Wisconsin form. The sooner you complete this step, the closer you
are to becoming a Universities of Wisconsin student. Find a helpful checklist of next steps at
wisconsin.edu/direct-admissions/.
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All Wisconsin high school seniors are eligible to apply to any UW university through the
traditional application process. If you would like to apply to a UW not included on the list
above, you can do so starting August 1 by completing the Universities of Wisconsin application
at apply.wisconsin.edu.

On behalf of the Universities of Wisconsin, congratulations again on your admission! We hope
to see you on a campus visit soon and in the freshman class of 2025! Don't forget to submit
your Direct Admit form as soon as possible. Your Direct Admit offer(s) expire May 1, 2025. If
you do not submit your form by this date, you can still submit a traditional application. If you
have any questions, do not hesitate to contact us at uwhelp.wisconsin.edu/get-help or check
out the Direct Admit Wisconsin FAQs at wisconsin.edu/direct-admissions/.

Sincerely,

Julie L. Amon, Ed.D.
Associate Vice President for Enrollment & Student Success
Universities of Wisconsin Administration

Once generated, these letters can be viewed by staff within the student profile by
navigating to Web Student Management > Student > Student Profile > Portfolio >
Attachments.

= Student  Food S Educator ~ Advanced Federal/State Custom
R ' Pl e Services | Service Qs A Access Plus = Features Reporting | Reports Q
‘H Attachments Tab * (‘LSSQJ E _T @ - ﬁFavolilesv {?_;New Window IEIMy Print Queue ”
Current “ | Student: |ABEL COL@®® | | < | » | @ Ranges Add Delete Transfer Pseudo
Future
Grad Grad Year (Grade): 2019 (GD) DOB (Age): 12/19/2000 (23) Entity, School, Status: 400, 400, A Default: 400, 400, A P
rades
Customize
¥ GPA Gender: M State ID: i i Gender Identity: X OtherName:
GPA Summary
Current Attachments
Historical
Rank Attachment Type: [ A1l Types v
Transcript Available Student Attachments B & View
Attachment
WUNCLB Type Descriplion Entered By Entered Dafe w Entered Time | File Size Add File
» Special Prgms Direct Admit Letter | Direct Admit Letter P oo l— 085/14/2024 9:13 AM FYIT
o ——— = = =T s gl iR
- Edit
» Special Ed = e N = o Dotels
) RT”MTSS L LR - L LB L | L -
» Discipline
L _ Ll L L) . - - m
) Health L] L L] - L _ - -
Activity [ = il u meem i o nE B =n En . m Ew 1K= |
L]
* Portfolio
v ' L] B L] I L] _ T [
Highlights S T N - ¢ A R on e e e 5., 5, A Y
Enroliment ! L
15 records displayed
» Grad Reqs
Test Scores -
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Also, by Students and Guardians from Family and Student Access under the Portfolio Tab:

Career Flans
Endorsements

Homeroom

Academic
History

Learning Center
School Directory

Login History

Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory
Report Directory

Report Directory

I Direct Admit Letter

Direct Admit Letter

Tue May 14, 2024 9:13am |

Report card

enhanced

Report Card

JTranccrint

Mon May 6, 2024 10:45am

ThuFeh 1 2024 0 10am

Although you should still be posting letters to Family and Student Access, Universities of

Wisconsin will also be mailing physical letters to students and guardians!
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